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Tabs3 Trust Accounting Software
Version 15 Tutorial

Thank you for reviewing Tabs3’s Trust Accounting Software (TAS). TAS was created as a tool to help profes-
sionals keep track of trust accounts that they manage. Checks written out of the trust check book, electronic
funds transfers, and deposits made to the trust checking account are entered into the software providing current
balance information for each individual trust account. Check registers can be printed for individual trusts, or for
individual trust checking accounts in 99 different bank accounts. TAS will help you keep the strict control you
need over trust accounts.

This tutorial uses a step-by-step approach that is ideal for self-guided instruction. Just sit down at your computer
with your keyboard in front of you, the tutorial at your side, and follow along. If you have any questions while
you are using the tutorial, you can refer to your TAS Manual or the Help in TAS. You can also get assistance by
calling our Technical Support Department at (402) 419-2210.

During the tutorial, you will be shown how to add trust accounts, checks, and deposits. You will also be shown
how to print a check as well as preview some of the reports available in TAS.

Throughout this tutorial, information that requires a physical response appears in bold type for easy identifica-
tion. For example:

Press:  F2 You should press the F2 function key.

Click: OK You should select the specified item by clicking the primary mouse button
(usually the left mouse button) once.

Double-click: Trust #100 You should select the specified item by clicking the primary mouse button
twice.

Right-click:  the Client field You should click the secondary mouse button (usually the right mouse
button) once on the specified field.

Type: WIL You should type the characters “WIL”.
Your responses will consist of PRESSing a key, CLICKing, DOUBLE-CLICKing, and TYPEing information.

Keep in mind that the instruction “Enter” requires that you press the Tab key after typing in the information
whereas the instruction “Type” does not.
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Installation and
Getting Started

Installing the Software

Using this tutorial requires that both System Configuration and Trust Accounting Software (TAS) are installed.
The installation process will install both of these systems at the same time. System Configuration is used to con-
figure users, passwords, groups, access profiles, and firm information.

Note: Instructions to install the software are provided on the CD.

Note: Unless you plan on working with this trial system from multiple workstations, it isn’t necessary to install
the software on multiple workstations. If multiple workstations will be working on this trial system, each
workstation should run the SETUP program located on the file server after installing the System Configuration
program and all other software. This process installs the required files and Windows shortcuts on the
workstation.

Sample Data

The Trial Software with Sample Data program group is found under the Tabs3 & PracticeMaster program
group and is always installed. Two sets of icons are included in this group: Sample Data icons and Refresh
icons. Use the Sample Data icons found in this folder to access the sample data. This data can be refreshed back
to its original status at any time by using the appropriate Refresh icons. Using or refreshing the sample data has
no effect on your regular data files because the sample data is located in a directory named TUTOR that is cre-
ated under the directory specified during the SETUP process.

Since the sample data is automatically installed, no additional steps are required to create the sample data unless
you have already added, changed, or deleted any of the information in the sample data. In that case, the sample
data can be refreshed back to its original status by using the appropriate Refresh icons in the same area.

Starting Up TAS

Let’s start TAS. This can be done via the Windows taskbar.

Windows Taskbar TAS is accessed via the Windows taskbar. Click the Start button, and then
point to All Programs. Point to the folder named Tabs3 & PracticeMaster
and then point to the Trial Software with Sample Data folder. Then click
the Trust Accounting with Sample Data icon.

Note: Make sure you select the Trust Accounting with Sample Data icon found in the Trial Software with
Sample Data program group. Otherwise, the sample data will not be present.

N
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Oops! Does your screen show “TAS Customization” instead of the TAS main application window? If so, press
the ESC key to close Customization. A message will be displayed indicating that customization data must be
saved before continuing. Click OK. You started TAS using the icon in the Tabs3 & PracticeMaster program
group. You must start TAS using the TAS with Sample Data in the Trial Software with Sample Data program

group.

After starting TAS, a message will be displayed indicating that while you are using this sample data, your system
date in the Tabs3/PracticeMaster software will be set to 11/17/2009. This will not affect any other software on

your computer.

Click: OK To close the dialog box and display the task folders.

Task Folders

There are two different ways to access the programs that are a part of TAS. We can access programs using the
menu bar or the task folders. The task folders in TAS are portrayed as various file folders that contain all of the
TAS functions. Each folder contains icons for the programs in the folder. The programs can be started by clicking
on the appropriate icon. Fig. 1 is an example of the TAS Window with the task folders displayed.

Title Bar T TAS - Task Folders - Jensen, Martin & Anderson, P.C. ‘ZHE”‘?\

i Fle Checks Reports Mainkenance  Utiities  Wiew  Window  Help

Tool Bar ——»f: 1oy e b [ CLBLL UK B QO F

W Task Folders - Jensen, Martin & Anderson, P.C. E]‘E”zl

™

Trust Accounts Trust Transactions Fayees Frint Checks

Task Folders

> BSAEEE

Check Register by Check Register by Check Register by Client Trust
Trust Account Check Mumber Payee Ledger

Exit

@ PFRun O Customize

<+— Menu Bar

— Application Toolbar

For Help, press Fi HACRO WM 9:40

Status Bar
Fig. 1, TAS Window

with Task Folders Displayed

We’ll now set up our first trust account.
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Section 1
Trust Accounts

Adding a Trust Account
We’ll use the task folders to access the trust account file. From the Main Task Folder,
Click: the Trust Accounts To open the trust account file. A window similar to Fig. 2 will be displayed.
icon

& Trust Account Information

Addess | Balances

Trust D: v

Bank Account: v

Mame [Last/First]

Mame Search:

Address Line 1:

Address Line 2:

Address Line 2

City: State: Zip:
Cantact Mame:

Phane: Federal ID #:

‘wiork Description:

Fig. 2, Trust Account Window

Click: [_u To assign the next available Trust ID. Trust ID 851.00 is automatically
entered in the Trust ID field. The word “NEW” appears in blue next to the
Trust ID field.

Press: the Enter key In the Bank Account field to accept “1” as the bank account number. The

Tab key or the Enter key can be used to advance through fields in this
program. Notice the bank description is displayed next to the Bank Account

field.
Type: Beck/Paul T. In the Name field.
Press: the Enter key To advance to the next field. By default, the text “Beck/Paul T.” has

automatically been entered in the Name Search field. The Name Search field
is used to alphabetize trust accounts.

Press: the Enter key To accept the default Name Search and advance to the next field.
Continue to enter the following information for the trust account.
Address Line 1: 1318 Logan Ave.

Address Line 2: (Blank)
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Address Line 3: (Blank)
City: Lincoln

State: NE

Note: TAS will automatically shift any lowercase letters entered in the State
field to uppercase.

Zip: 68506
Contact Name: Paul Beck
Phone: 402-438-0927

Notice that the Federal ID # defaults to “12-3456789”. This Federal ID # represents the Federal ID # of the ficti-
tious law firm set up in the sample data (in other words, your law firm). TAS has the ability to print 1099s for
any payees paid by the trust account. The payer shown on the 1099 can be either the trust account or your firm.
The Federal ID # entered in this field determines who the payer is. Since the Federal ID # is the same Federal ID
# defined in System Configuration, we have indicated that the payer on the 1099 form will be your law firm.
TAS will also warn you if you add two trust accounts with the same Federal ID # that do not match the Firm’s

Federal ID #.

Press: the Enter key To accept the default Federal ID #.

Type: Divorce In the Work Description field.

Press: the Enter key Notice that the second program tab, the Balances tab, is automatically

displayed when you press the Enter key in the last field of the Address tab.

The Balances tab includes a Date Opened field to specify when the trust account was added. The default Date
Opened is the current system date. The Responsible Attorney field is used to indicate which attorney is in
charge of the trust account. The default attorney is attorney #1, Michael L. Jensen.

The Current Trust Balance field is typically not edited because the deposit and check transactions automati-
cally adjust this field. The Desired Minimum Balance field is used to record a minimum balance that should be
maintained in the trust account. When entering transactions, TAS will give you a warning if a trust account drops
below the Desired Minimum Balance. If this occurs TAS gives you the ability to print a Trust Account List that
only includes trust accounts whose balances are below their Desired Minimum Balance.

Note: If you are integrating with Tabs3, two other fields will be available: Amount to Bill and Target Balance.
These fields can be used to trigger a billing statement in Tabs3 to automatically bill a flat amount or calculated
amount to replenish a client’s trust account.

Since we will accept the defaults for the fields on the Balances tab, we are now ready to save the new trust ac-
count record.

Click: E To save the trust account record for Paul Beck.
Click: e, To close the Trust Account window and return to the task folders.

Now that we’ve entered a trust account, let’s enter a payee.
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Section 2
Payees

Adding a Payee

When checks are entered in TAS, you can select a payee from the predefined payee file or simply enter the payee
name. By selecting a payee already present in the file, the operator will save time by not having to reenter the
payee name and address information. Payees are entered using the Payee program or by adding them “on the fly”
during data entry. Let’s look at the payees that have already been defined and add a new payee.

Click:
Click:

Click:

Click:

File
Open

Miscellaneous

the Payee tab

To display the File menu

To display the Open menu.

To display the Miscellaneous window. Notice that this window includes three
program tabs: Attorney, Payee, and Bank Account. These three tabs make
up the files that must be set up before you can add new trust accounts and

transactions.

To select the Payee program.

A blank data entry screen is displayed. To see the payees in the file, we can click the drop-down button to dis-
play a Payee Lookup window or we can use the F3 and F4 keys to display the previous and next payee.

Press:

Press:

F4

F4 again

To display the first payee. The first payee in the sample data is “Banks,
McCobe & Heins”. Each payee can have up to 3 address lines of 35
characters each. A Federal ID # is maintained for those payees who require a
1099-Miscellaneous form.

To display the next payee which is Bryan/LGH East Medical Center. Notice
the payees are displayed in alphabetical order.

Notice the e and e buttons shown on the toolbar. These buttons perform the same functions as the F3 and F4
keys. Try clicking on these buttons to scroll through the records in the payee file.

Let’s add a new payee for a court reporter who we will be paying later in this tutorial.

Click:

Type:

Press:

Type:

Press:

Type:

[_ (New)

Henderson/Chris
the Tab key

6125 Rosebriar Ct
the Tab key

Lincoln, NE 68507

To indicate we will be adding a new record to the payee file.

In the Payee Name field. The slash character tells TAS to print the payee as
“Chris Henderson” on checks.

To advance to the Payee Address Line 1 field. The label “New” will be
displayed indicating this is a new record.

In the Payee Address Line 1 field.
To advance to the Payee Address Line 2 field.

In the Payee Address Line 2 field.

(o)}
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Press:

Type:
Click:

Click:

Click:

Click:

the Tab key twice

267-12-4321

Box 7

¢ @

To advance to the Federal ID # field.
In the Federal ID # field.

To view the 1099 Info options.

For the 1099 Info option. This tells TAS that we want the information for this
payee to print in box 7 (Nonemployee compensation) when 1099 Forms are
printed.

To save the new payee record.

To close the Miscellaneous Files window and return to the task folders.

Section 3

Checks, Deposits & EFTs

Entering a Deposit

Trust transactions consist of checks, deposits, electronic funds transfers (EFTs) and voids.

Let’s say that Attorney Michael L. Jensen has agreed to represent Mr. Paul Beck for his divorce and requires a
$2,000 retainer. Any funds not used for fees or costs will be refunded to the client. Mr. Beck has written out a
check in the amount of $2,000 to the law firm. Let’s enter the payment as a deposit in TAS to Mr. Beck’s trust

account.
From the Main Task Folder,

Click:

the Trust Transactions

icon

To open a Trust Transactions window. A window similar to Fig. 3 will be
displayed.

TAS Version 15 Tutorial
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3 Trust Transaction Entry

Tranzaction ‘ Tabs3
[rate: mmddddppy | Amaount:
Drescription: Balance: 0.00
Mema: | | El
Payee Mame: | | & Add Payes
Payee Address 1: | |
Payee Address 2: | | Uszer ID: l:l
Payee Address 3: | | Diate Entered: | mm/dd/
Trust Transaction Entry List Trust ID: 851.00 @
Fef © [rate Check # Amaunt Description Fayee ~
A
Deposzits: 0.00 EFTs 0.00 Checks: 0.00 Amaount: 0.00

Fig. 3, Trust Transactions Window

Notice that Trust ID 851.00 is displayed by default in the Trust ID field. TAS remembers the last trust account
used during data entry and displays it as the default.

Press: the Enter key To accept Trust ID 851.00. Once again, the Tab key or Enter key can be used
to advance through fields in this program.

Press: the Enter key To accept bank account #1.

Press: the Enter key In the Reference ficld to accept the next available reference number. Each
trust transaction is assigned a unique reference number that is used for editing
purposes.

Click: Next to the Type field to display the available transaction types.

Click: Deposit To indicate we will be adding a deposit. Notice that the Check # and Payee

fields are dimmed. These fields are not used for deposit transactions. We will
accept the defaults for the Save/Purge and Date fields.

Double-click: ~ the Amount To highlight the value shown in the Amount field.
field

Type: 2000 In the Amount field. Notice that the Trust Balance shown below the Amount
field is changed from 0.00 to 2000.00.

Press: the Tab key To advance to the Description field.
Type: Retainer received, In the Description field.
check #8456
Press:  Ctrl+S To save the deposit transaction. The Ctrl+S keystroke is a shortcut to save a
record.
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Trust Transaction Entry List

Notice that once the deposit is saved, it is displayed in the Trust Transaction Entry List shown at the bottom of

the window. This list can optionally be displayed from the data entry window by clicking the button on the
toolbar. Totals for Deposits, EFTs, and checks are displayed, as is the net amount for all of the Trust Transac-
tions in the list . Double-clicking a transaction in the list automatically retrieves that transaction in the data entry
window allowing you to review, edit, or delete the transaction.

The list includes all transactions entered for one of the following filters: Trust ID, Transaction Date, or Entry
Date. The heading in the upper left corner of the list displays which filter is being used. The filter can be changed
by clicking the @ button in the upper right corner of the list.

You can change how the transactions are sorted in the list by clicking a column heading. An ascending =] sort in-

dicator will be shown when the column is in ascending order. Clicking the same column heading again will re-
verse the sort order and change the sort indicator to a descending L1 sort indicator.

Entering a Check Transaction

Let’s say that Attorney Jensen will need a $200 check to pay Chris Henderson, the court reporter, for a deposi-
tion that he will take with him to the courthouse.

Press:  the Enter key three To accept the default trust account, bank account and reference number. TAS
times. uses the last trust account accessed as the default trust for subsequent trust
transactions. Notice that the Trust Balance of $2,000 is shown below the
Amount field.

Type: C In the Type field to indicate we are adding a check transaction.

Press: the Enter key To advance to the Check # field. Notice this field defaults to 0. When a
check number of “0” is entered, it indicates that TAS will be used to print the
check. The check number will be assigned when the check is printed. If TAS
will not be used to print a check, you can enter the actual check number in the
Check # field. Check transactions that have a Check # other than “0” are
considered paid and will not be able to be printed using TAS. We will leave
this field at the default of “0” to indicate we will be printing the check using

TAS.
Double-click:  the Amount To highlight the value shown in the Amount field.
field
Type: 200 In the Amount field. Notice that the Trust Balance is changed from 2000.00
to 1800.00. Even though the check hasn’t been printed, this amount shows
the balance of the trust account including the current trust transaction.
Press: the Enter key To advance to the Description field.

Type: Court Reporting Fee In the Description field.

Press: the Tab key To advance to the Memao field.

In the Memo field. The Memo field can optionally print on a check to the left

Click: the button . .
of the signature line.

Press:  the Tab key To advance to the Payee Name field. Notice the Add Payee check box. This
box can be used to add Payees to the Payee file on the fly when entering trust
transactions.
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Type: Hen You can type the first few letters of the payee to speed up the data entry
process. Notice Henderson/Chris is displayed below the Payee Name field
and highlighted. TAS will automatically search for the first occurrence of
anything that has been entered in a lookup field, such as the Payee Name

field.

Press: the Enter key To select Henderson/Chris.

Press:  Ctrl+S To save the deposit transaction. The Ctrl+S keystroke is a shortcut to save a
record.

Quick Print Check Feature

Now that we’ve added the check transaction, we can use the Quick Print Check feature to print this transaction.
From the Trust Transaction Entry screen,

Click: Next to the Reference field to view the Trust Transaction Lookup window.

Double-click: our $200.00 To display the transaction in the Trust Transaction Entry window.
transaction

Click: To open the Print Trust Check window.

When generating checks, TAS allows you to display the checks prior to printing them. This allows you to con-

firm the information on the check before it is printed. The information for the check is not processed when the

check is displayed, it is only processed when the check is printed. Thus, you can display the check and make any

necessary corrections in the Trust Transactions program before the check is actually printed.

Let’s display the check before we print it.

Click: Preview To begin previewing the checks. You will be asked to enter a beginning
check number for the bank account. This number is determined by taking the
“Last Check Number Used” from the bank account file and adding one to it.
We will accept the default.

Click: OK To accept the default beginning check number.

The check will be displayed in the Preview window. If desired, you can click and drag on any edge of this win-

dow to resize it or you can maximize the window. As you can see, the preview window includes a graphical rep-

resentation of the check so that you can see exactly how the check will print.

The font used for printing and previewing reports is based upon the width of the report. TAS can either select

font sizes for you automatically or you can select different fonts and sizes for different report widths. The fonts

and font selection options are defined in Print Setup.

Use your arrow keys or scroll bar to scroll through the information on this check. When you have finished view -
ing the check,

Click: Close To close the Preview window.

We are now ready to print the check.

Click: To indicate we want to print the check.
Select: the Printer option

Click: OK To begin processing the check. You will be asked to enter a beginning check
number for the bank account. We’ll accept the default.

10

TAS Version 15 Tutorial



Click: OK To accept the default beginning check number.

You will be asked if you would like to print a test pattern. A test pattern allows you to adjust your check form in
the printer so the check information is properly aligned on the check form. At this time we will print a test pat-
tern.

Make sure your printer has paper and is turned on.

Click: Yes To indicate you want to print a test pattern. A test pattern will print on the
selected printer.

Note: If the test pattern didn’t print, make sure there is paper in the printer
and the printer is turned on. Try again to print a test pattern. If nothing prints,
call our Technical Support Department for assistance.

The TAS Test Pattern window will be displayed again. This time we will not print a test pattern and print the ac-
tual check. If you need to insert another piece of paper in the printer, do so now.

Click: No To indicate that you do not want to print another test pattern. The check will
begin printing.

Take a look at the check you just printed. Keep in mind that there are several options in the TAS Check Printer
Setup window that can be used to customize the information included on the check form. These options include
printing the Trust Account Name and the Trust ID on the check and check stub. In the Sample Reports section of
the TAS Manual, the areas of the check that can be customized are shown.

Printing Batch Checks

We just showed you how to print one check at a time in the Trust Transaction Entry window. Checks can also be
printed in batches by using the Print Checks program in TAS. For more information about the Print Checks pro-
gram, see the TAS Help.

We have entered a deposit and a check transaction. The only types of transactions we haven’t entered are EFTs
(electronic funds transfer) and voided transactions. Entering an EFT transaction is identical to entering a check
transaction except the transaction type of EFT is used and no check number is specified. We will not enter an
EFT during this tutorial. Entering a void is identical to adding a manual check except the transaction type of
Voided is used. We will not enter a voided check during this tutorial.

Click: e, To close the Trust Transactions window.

A window will be displayed allowing you to print a verification list. The verification list can be used as a means
of verifying the data entry additions, changes and deletions made. This list can be printed after each data entry
session, at the end of the day, at the end of the week or whenever desired. Use of the verification list is optional.

Click: Cancel To close the Verification List window.

You have now seen how easy it is to enter data in the Trust Accounting Software. Next, let’s take a look at two
reports available in TAS.
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Section 4
Reports

Check Register By Trust Account

The first report that we will look at is the Check Register By Trust Account.

From the task folders,

Click: the Reports Task
Folder

Click: the Check Register By
Trust Account icon

Clle L2

Double-click: 851.00

Click: the Transactions tab
Click: the Options tab
Click: the Sort tab

Click: OK

Click: Preview

To display the icons available in the Reports task folder.
To open the Check Register By Trust Account window. The Trust Accounts
tab will be displayed.

Shown next to the beginning Trust ID field.

To select Paul Beck’s trust account. Notice that 851.00 is automatically
entered in the Ending Trust ID field.

To display the options on the Transactions tab. This tab allows you to
specify a date range for the trust transactions and specify if you want to see
checks set to save, purge or both. Since we want to include all transactions
for this account, we will leave this range at the default.

To display the options available on the Options tab. We will not change any
of these options.

To display the options available on the Sort tab. We will not change any of
these options.

To display the Print dialog box.

To begin displaying the report. All of the activity entered for the Paul Beck
trust account is shown.

After you have finished viewing the report,

Click: Close

Click: Cancel

To close the Preview window.

To close the Check Register By Trust Account window.

Check Register By Check Number

The next report that we will look at is the Check Register By Check Number. When the report is printed without
a running balance, this report can be used to print a list of checks in check number order. Any gaps in the check
number sequence are shown with asterisks.

From the Reports task folder,
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Click: the Check Register By  To open the Check Register By Check Number window. The Transactions
Check Number icon tab will be displayed allowing you to select transaction dates, check number
ranges, checks set to save, purge or both and different transaction types.

Click: the Options tab To display additional options for the Check Register By Check Number.
Notice that TAS gives you the option to include a running balance on this
report. When a running balance is included, the transactions are printed in
date order. We will not change any of these options.

Click: OK To accept the selected options. The Print dialog box will be displayed. We
will view this report using the Preview window.

Click: Preview To begin displaying the report. Notice that the check transactions for bank
account #1 are shown in check number order. Notice that Check # 45341 is
voided and marked as being reconciled. This check was used to print the test

pattern.

Press:  Ctrl+PgDn To display the top of the second page. This page shows the transactions for
bank account #2.

Press: Ctrl+PgDn To display the top of the third page. This page shows the transactions for
bank account #3.

Press: Home To display the beginning of the report.

Click: Close To close the Preview window.

Click: Cancel To close the Check Register By Check Number window.

Section 5
Bank Account Reconciliation

TAS includes a Bank Account Reconciliation program that is truly easy to use and will expedite the reconcilia-
tion of your bank accounts. Let’s take a look at the Bank Account Reconciliation program.

From the menu bar,
Click: Checks To display the Checks menu.

Click: Bank Account To start the bank account reconciliation.
Reconciliation

We will reconcile bank account #1.
Type: 1 In the Beginning Bank Account # field.

Press: the Tab key To advance to the Ending Bank Account # field. Notice 1 is automatically
entered in the Ending Bank Account # field.
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Note: TAS allows you to specify a range of bank account numbers for the
reconciliation because some firms use the TAS bank accounts for separate
funds that are actually run through the same physical bank account.

Press: the Tab key To advance to the Beginning Statement Balance field.

Type: 2200.00 For the Beginning Statement Balance. This figure is taken from the bank
account statement.

Press: the Tab key To advance to the Ending Statement Balance field.

Type: 4200.00 For the Ending Statement Balance. This figure is also taken from the bank

account statement.

You have the option to enter a specific Cut-Off Date for the Bank Reconciliation. We will be using 10/31/2009
for the Cut-Off Date.

Press: the Tab key To advance to the Cut-Off Date field.
Type: 10/31/2009 For the cut-off date.
Click: Start To begin the reconciliation.

A window similar to the following will be displayed:

¥ Bank Account Reconciliation

]
L= ) ——

F | Check # Date
[ 3 | !

45336 10/15/09 o

45337 10/30/09 1382 35 Payment of October Invoic Jensen, Martin & anderson,

Deposit  10/02/09 3.22 Interest Depasited

Deposit  10/08/09 1000.00 Initial Deposit - Check 232

EFT 10/30/09 322 Interest transtened to IOLT I0LTA Interest

Deposit  10/30/09 132340 Retainer Papment Receive

Begin Strit Balance: 2200.00 Cleared Balance: 220000
- Cleared Checks: 0.00 - Ending Stmt B alance: 420000

- Cleated EFTs: By Difference 200,00
+ Cleared Depasits nm o

Cleared Balance: 220000

oo

Fig. 4, Bank Account Reconciliation Window
The trust transactions for this bank account include check numbers 45335, 45336, and 45337, three deposits, and
one EFT. Our bank statement shows that checks 45335 and 45336 have cleared the bank. Let’s mark this range
of checks as cleared. Check #45335 should already be highlighted.

While holding down the Shift key,

Click: Check 45336 To highlight checks 45335-45336.

Press: the Space Bar Notice that the “R” (Reconciled) column on the left side of the list of checks
now has a check mark indicating that these checks have been tagged as
reconciled.

You may have noticed that the Cleared Checks figure shown in the lower portion of the window was automati-
cally adjusted as well as the Cleared Balance figure and Difference figure. Notice that the number 2 next to the
Cleared Checks figure represents the number of cleared checks.

The deposits shown in the Reconciliation window are also shown on the bank account statement

14
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Press:  Down-Arrow To highlight the first deposit.

Press: Enter To mark the deposit as reconciled.

Double-Click:  1000.00 To mark the $1000.00 deposit as reconciled.

Click: the last deposit listed  To highlight the last deposit.

Press: the Space Bar To mark the deposit as cleared. Notice that the Cleared Deposits figure is also

adjusted as well as the Cleared Balance figure and the Difference figure. The
Difference should be $3.22.

QOops! If your Difference figure does not show the amount of 3.22, check the
Beginning Statement Balance and Ending Statement Balance you entered.
The Beginning Statement Balance should be 2,200.00 and the Ending
Statement Balance should be 4,200.00. Also, all trust transactions on the
screen should be marked except for the EFT and check number 45337. If you
entered an incorrect Beginning or Ending Statement Balance, you can easily
correct it by doing the following. Press ESC to exit the reconciliation. Click
Yes when asked if you want to save your work. Restart the reconciliation
program, enter “1” for the Beginning and Ending Bank Account and enter the
correct balances.

The EFT shown on the screen for $3.22 is also included on the bank statement. Let’s mark the EFT as cleared.
Press:  Up-Arrow To highlight the EFT.

Press: the Space Bar To mark the highlighted $3.22 EFT transaction. Notice how the figures at the
bottom of the window are adjusted.

Notice the label “In Balance” is now shown for the Difference. This means your trust account is now in balance
with your bank statement so we can now finalize the reconciliation. Finalizing the reconciliation consists of TAS
marking the transactions permanently as reconciled so they are not shown as unreconciled for the next reconcilia-
tion.

Before we finalize the reconciliation, let’s print a Reconciliation Report.

Click: @ (Print) To display the Bank Account Reconciliation Report window.

The Bank Account Reconciliation Report can be printed using a Detail or Summary format. The report can also
include unreconciled transactions, reconciled transactions, or both unreconciled and reconciled transactions. You
can include checks only, deposits only, EFTs only, or all transaction types. This report cannot be printed once the

reconciliation has been finalized.

Click: OK To accept the defaults for the report. The Print dialog box will be displayed.
The Preview option should already be selected by default.

Click: Preview To begin previewing the report. Using your arrow keys, scroll through the
information on this report. Notice that the report includes information about
each transaction as well as the balance information calculated by the Bank
Account Reconciliation program.

After viewing this report,

Click: Close To close the Preview window.

We are now ready to finalize the Bank Account Reconciliation.

Click:  Finalize To finalize the reconciliation. You will be asked to confirm that you want to
finalize the reconciliation.
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Click:  Yes To confirm that you want to finalize the reconciliation.
After the reconciliation has been finalized, a message will be displayed indicating that the process has completed.

Click: OK To continue. The Bank Account Reconciliation window will be cleared and
you will be able to select a new account to reconcile.

Click: @ To close the Bank Account Reconciliation window.

TAS’s Bank Account Reconciliation program helps take the drudgery out of reconciling your bank statements by
enabling you to perform this task quickly and easily.

Thank You!!

This wraps up the TAS tutorial for the trial system. We would like to thank you for taking a look at how our
Trust Accounting Software works. You should now have a working knowledge of the system and we hope you
feel more comfortable with it after this “hands-on” experience. If you have any questions, please feel free to give
us a call at (402) 419-2210.

16
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Purposes & Benefits
of TAS Reports

The following table shows the various reports in TAS including their purposes and benefits.

PURPOSES & BENEFITS OF TAS REPORTS

with their respective balances and
grand totals in detail or summary
format. Flexible subtotaling op-
tions allow subtotaling by bank
account or attorney or both. Use
current balances or specify bal-
ances as of a selected date.

Report Purpose Benefit When to Run
Bank Account List Provides a list of bank accounts Quick access to bank account bal-| As needed.
including their current balance ance.
and last check number used. Also
includes GLS account numbers
and Tabs3 transaction codes for
integration purposes.
Payee List Provides a list of payees and ad- | Easy to review address informa- | As needed.
dresses in alphabetical order. tion, Federal ID numbers and
which 1099 box is set up for the
payee.
Trust Account List Provides a list of trust accounts A “totals only” report can be As needed.

printed. Zero balance trusts can
be excluded and a list of trust ac-
counts whose balances fall below
the desired minimum balance can
be printed. Optionally include
dates of last deposit, check and
EFT.

Transaction
Verification List

Provides a paper audit trail of all
trust transactions entered from all
sources in bank account or entry
order. Changes and deletions are
also included. Separate lists are
maintained for each User ID.

Allows the data entry operator to
check his/her work after each
data entry session.

Usually after each data entry ses-
sion. TAS can be configured to
not allow deletion of the verifica-
tion lists unless they have been
printed.

Reconciliation Report

Shows reconciled trust transac-
tions, unreconciled trust transac-
tions or both in a summary or de-
tail format. Option to include
checks, deposits, EFTs or all trust
transactions.

Provides a paper listing of all
trust transactions reconciled dur-
ing the current reconciliation. A
useful tool for determining where
discrepancies reside when not in
balance.

As needed.

Voided Check List

Includes checks that have been
voided since the last time transac-
tions were purged.

Provides an audit trail of voided
checks that includes the date the
check was voided.

As needed and before running the
Purge Transactions program.

Check Register by Trust
Account

Includes activity by individual
trust account for a range of trust
accounts. Transactions are printed
in date order. Voided checks are
included.

Easily review activity for trust ac-
counts. Includes reference num-
bers for editing purposes.

As needed.

Check Register by Check
Number

Provides a listing of checks, de-
posits and EFTs for a specified
date range. Include or exclude
voided checks.

Provides a complete list of checks
in check number order with an
optional running balance. Easy to
spot missing check numbers.

Annually and as needed.
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PURPOSES & BENEFITS OF TAS REPORTS

for a range of trust accounts.
Transactions are printed in date
order. Voided checks are not in-
cluded. Optionally exclude zero
balance trusts or no activity
trusts.

Report Purpose Benefit When to Run
Check Register by Payee Provides a listing of all checks Easily determine if checks or As needed.
and EFTs for specified Payees. EFTs have been written to a
Include or exclude voided payee and what Trust account it
checks. was from.
Client Trust Ledger Includes activity by trust account | Includes a running balance after | As needed.

each transaction. This report can
be given to the client as a record
of all activity on the account.

1099 Report

Verify 1099 information before
printing forms or preparing APS
merge file. Provides a list of trust
accounts who have paid payees
more than a specified amount in a
calendar year. Optionally include
detailed information for each dis-
bursement.

Easily determine if Federal ID
numbers are entered and verify
which 1099 box is set up for the
payee.

Annually and as needed.

1099 Form Fulfills IRS reporting require- Eliminates manual preparation of | Annually and as needed.
ments. forms. Streamlines mandatory an-
nual chore.
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For more information:

www.Tahs3.com
(402) 423-1440

Software Technology, Inc. e 1621 Cushman Drive e Lincoln, NE 68512 e 402.423.1440



